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[bookmark: _Toc25768641]FRedit from Square One 
Welcome to FRedit from Square One. FRedit is a powerful find-and-replace macro that, like all macros, will increase your editing speed and efficiency. This self-paced guide will teach you how to use FRedit.
[bookmark: Macros_from_Square_One]Prerequisites: FRedit is an intermediate macro. To use it, you should already be regularly using macros in your editing and feel comfortable installing macros and assigning them keyboard shortcuts. If you do not, then please start with the Macros from Square One guide to teach you these skills:
[bookmark: _Hlk167954025][bookmark: _Hlk167954060]•	Mac: www.wordmacrotools.com/downloads/MSO_Mac
•	PC: www.wordmacrotools.com/downloads/MSO_PC 
Or for a simpler, less-technical approach, start with the Macros – Free Trial guide:
•	www.wordmacrotools.com/downloads/FTMacros_instructions
How to use this document: Read through the first three sections and then roll your sleeves up and get ready to start learning and practising the new skills. You may want to get together with a couple of other editors to learn together; two or three heads are often better than one. 
[bookmark: _Hlk106638384]If you want to share this document with a colleague (please do!), it would be best to share the download link, as this will ensure that they have the most up-to-date version: 
•	www.wordmacrotools.com/downloads/FSO-instructions 
A note on style: Although this document follows UK style conventions, because editors around the world use FRedit, examples are shown using other styles as well.
FRedit – an introduction
FRedit is a global find-and-replace macro. It is intended to be run at the beginning of a project to clear up global mistakes and inconsistencies before you begin editing. This could be removing double spaces, replacing a double hyphen with an en dash, or correcting obvious spelling errors … and much, much more.
You are likely already familiar with Word’s find-and-replace function, which will also remove double spaces and other tasks. However, in Word each find and replace must be carried out separately, whereas FRedit will execute as many find and replaces as you need, all at once – saving you a lot of time. 
[bookmark: _Your_first_macro]Using FRedit requires you to learn some new information and skills:
•	The types of changes FRedit is suited to make… and not suited to make.
•	How to tell FRedit what changes you want it to make, which is done through a FRedit list.
The rest of this document will teach you these skills.
What type of edits is FRedit suited for?
FRedit was designed to apply basic style and usage conventions and correct pre-identified global errors, such as misspelt proper nouns. You run it before you begin editing as a preflight step. Because FRedit cleans up rote edits, it frees up your brain to focus on matters that require editorial judgment. 
Here are some common ways to use FRedit to clear up routine errors and conventions:
•	Changing double spaces to single spaces
•	Changing straight quotes to curly quotes
•	Correctly applying dashes (per your style guidelines)
•	Placing commas and periods inside or outside the end quote mark (per your style guidelines)
•	Removing superscripts from ordinals: 1st, 2nd, etc.
•	Applying standard spellings per your style guidelines, such as ‘e-mail’ to ‘email’
•	Correcting pre-identified errors, such as inconsistent spellings of proper nouns
A word of caution: Since FRedit is a global find-and-replace tool, we must ensure that we use it to fix mistakes for which the correction is the same across the entire document – otherwise we will introduce mistakes. For example, not all instances of ‘work out’ should blanketly be changed to ‘workout’, which would produce an error if the text had the sentence ‘I work out at the gym five days a week’. For some edits, you need to check the context to determine whether a correction is warranted. So FRedit should not be used to make edits that can’t be universally applied.
How do I tell FRedit what I want it to change?
FRedit does not come with any preloaded find and replaces. You give it a list – called a FRedit list – of what you want it to change. A FRedit list is a Word document that lists the individual find and replaces. You will create a FRedit list for each project and will probably want to save that file in the project folder – but you can save it elsewhere if you prefer. 
When you want to run FRedit, you must open both the document itself and the FRedit list. Before you run FRedit, make sure your cursor is standing inside the document so FRedit knows which document you want it to correct, since you may have other open documents. You will be practicing this shortly.
These are just the basics for now. More is to come about how to set up a FRedit list. First, let’s see how FRedit works.
See what FRedit can do – exercise #1
Rather than trying to describe what FRedit is capable of, learn how it works by running it on sample text. Note that for this exercise, we have already created the FRedit list for you. Later you will learn how to set up a FRedit list yourself. 
Follow these steps:
1.	Install FRedit. You can access the code here: www.wordmacrotools.com/macros/F/FRedit.
2.	You can assign it a keyboard shortcut, but it’s not essential since you run it only one time per document.
3.	Download and open these two files (if asked, click the prompt ‘Enable Editing’ on both documents):
•	FSO–exercises
•	FSO–FRedit_List
4.	With the cursor standing inside FSO–exercises, run FRedit using either the Macro dialogue box or its keyboard shortcut. If any prompts arise, such as to ‘turn on Track Changes’, follow those instructions and then run FRedit again.
5.	Learn what FRedit can do by reading through the edited text in FSO–exercises. The text contains explanations of how FRedit works. Toggle between Simple Markup and All Markup mode to see the changes FRedit made. 
Key takeaways from exercise #1
Let’s summarize the key points. As you saw in this exercise, 
•	FRedit can make a variety of spelling, punctuation, and style changes.
•	It is adaptable to the style conventions you use for each project and the errors particular to a given document.
•	You must consider each change you want FRedit to make to verify that it qualifies as a global change. Remember the US/Unites States and advice/advise examples in the exercise? That’s why it’s important to first test your FRedit list on a copy of the document.
•	You communicate your changes to FRedit through a FRedit list, which you can customise for any given project. 
•	To run FRedit, both the FRedit list and the document must be open with the cursor placed in the document so FRedit knows which file you want it to edit.
How to set up a FRedit list
To create a FRedit list, open a blank document. First, you must label the document as a FRedit list (so FRedit can find it) by placing | FRedit (a vertical bar and the word ‘FRedit’) at the top. 
Now you are ready to start listing the changes you want FRedit to make. To do that, you arrange each find-and-replace item following two simple rules:
1.	Each find-and-replace item must be placed on its own line.
2.	The find element is listed first followed by a vertical bar and then the replace element:
find item|replace item
Let’s look at this in more detail. Open the FSO–FRedit_list and read through the entries under the line | edits for exercise #1. (Ignore those for exercise #3 for now.) Look at each entry and compare the find text on the left to the corrected text after the vertical bar. Here is an explanation of some of the entries:
•	To correct the spelling of a word, place the misspelled word first followed by a vertical bar and the correctly spelled word, such as the misspelling of Paul’s name:
Beverly|Beverley
•	The same format applies when you use FRedit to correct the capitalization of a word, as in ‘FRedit’ and ‘Track Changes’, and abbreviating words or spelling them out:
Fredit|FRedit
track changes|Track Changes
US|United States
United Kingdom|UK 
•	To change two spaced hyphens into a spaced en dash, place the spaced hyphens first followed by a vertical bar and a spaced en dash:
^32--^32|^32–^32
The ^32 is the computer code for a space; it is used for clarity. You could use the spacebar instead, but when you scan your FRedit list, the spaces are invisible, making it difficult to see if you are properly formatting the find-and-replace items, for example:
  |  
•	To change a straight quote to curly (single and double, respectively): 
^39|’
^34|”
The ^39 is the character code for a straight single quote; ^34 is the code for a straight double quote. You could use straight single, or double, quote mark instead of the character code. However, FRedit will then change all quote marks – straight and curly – to curly, introducing unnecessary edits. 
Exercise #2
Create FRedit list entries for each of these scenarios. See the answer key at the end of this document.
1.	Change the spelling of ‘health care’ to a single word.
2.	Write out CO2 as words.
3.	Change two dashes surrounded by spaces into an em dash with no spaces.
4.	Remove the apostrophe in decades, such as 1920’s.
[bookmark: _Hlk123981485]5.	Remove the superscript in ordinal numbers, such as 1st.
6.	Change all nonbreaking spaces (which can occur when text has been copied from the internet or Google Docs) to regular spaces. (Consult Appendix 1 for the code for a nonbreaking space.)

Break time! You’ve learned a lot so far. This is a good place to pause for a bit to let the information sink in. Come back tomorrow or in a few days, refreshed and ready to learn about other FRedit features. 
Additional FRedit features
At its heart, FRedit is a find-and-replace tool that works globally. But it also offers editors other features to make you even more efficient. Here’s a breakdown of those features and how to format your FRedit list accordingly:
•	Track all the changes: As you saw in exercise #1, you can set up FRedit to check if tracking has been turned on, and if not, it will prompt you to do so. To add this handy feature, place this line at the top of your FRedit list:
| track = yes
•	Turn off tracking for select edits: You may not want to track straightforward edits like changing a double space to a single space, which can clutter a document and overwhelm an author. For any change you do not want to track, simply apply a strikeout to the entire line. In the below example, edits to remove double spaces will not be tracked.
^32^32|^32
•	Change both uppercase and lowercase instances of a word: FRedit’s finds and replaces are case-sensitive by default. Therefore, if you tell it to change ‘towards’ to ‘toward’ (as editors in the US typically do), it will ignore all capitalised instances. If you want FRedit to change the uppercase instances too, you need two FRedit list entries:
towards|toward
Towards|Toward
*Note: If you want to change ALL CAPS instances too, then you will need to use the bent pipe technique listed in Appendix 2.
•	Organize your list with explanations: To help you remember what an entry does or to organize a group of entries, you can insert explanatory text. In the FSO_FRedit_list, note the line | changes for exercise #1. The vertical bar is the very first character on the line, signalling to FRedit to ignore this line. You can also use this method to annotate an individual entry:
| changes a nonbreaking space to a regular space
^s|^32
•	Highlight certain edits: You can tell FRedit to apply highlighting to specific edits that you want to review in context while you are editing. The highlighting will catch your attention as you are working. To do this, in your FRedit list, apply highlighting to the entire line:
CO2|carbon dioxide
	 Tip: You can also have FRedit highlight specific words in a document, such as easily confused words like ‘lead’, which authors often write when they mean ‘led’. To do that, place the confusable word on both sides of the vertical bar and highlight the entire line. You should also apply a strikethrough to eliminate tracking (since you aren’t changing anything).
lead|lead 
[bookmark: myTempMark2]•	A note about the font of your FRedit list: To avoid FRedit making any changes to the font size or type, set the text in your FRedit list and document to the Normal style with no overriding font size and type settings, e.g., do not use Normal + Times New Roman, 10 pt; only use Normal, as displayed in the Styles Pane. But Normal + Strikethrough (or Normal + Red) is OK.
Useful FRedit features – exercise #3
This exercise will demonstrate practical applications of the FRedit features we’ve seen so far.
Follow these steps:
1.	Return to the FSO–exercises document and scroll down to exercise #3.
2.	Do NOT rerun FRedit. When you ran it for exercise #1, it made the edits for exercise #3 as well.
3.	Read through the text, which will walk you through the different FRedit features. Toggle between Simple Markup and All Markup views to see the changes that FRedit made. Also consult the FSO–FRedit_list document to see how the find-and-replace entries are formatted. You may want to print the FRedit list or open both documents in split-screen view for easy reference as you read through the text. 
If you find the red squiggles in the FRedit list distracting, you can tell Word to hide spelling errors. On a Mac, go to Tools > Spelling and Grammar > Hide Spelling Errors. On a PC, go to File > Options > Proofing; Under ‘Exceptions for [Document name]’, select ‘Hide spelling errors in this document only’.
Mini exercise #4
Practise all you’ve learned. When you’ve completed these exercises, consult the answer key at the end of this document. If you get stumped, you may want to create a FRedit list with these entries and sample text to run it on. Consult Appendix 1 for a list of character codes and Appendix 2 for a summary of the FRedit list elements and features.
Part A: Describe what each of the below FRedit entries will change.
1.	skillset|skill set
2. 	O|°		(If you’re unsure, try using the WhatChar macro to see what each character is.)
3.	January|Jan.
4.	manufactures|manufactures
5.	
firstly|first
Firstly|First
Part B: Describe the error for each of the below FRedit items. How would you correct it?
1.	problem solving|problem-solving 
2. 	“.|.”
3.	trail head|trailhead

Break time! You’re almost done. If you feel saturated with information, take a break to give your brain time to absorb what you’ve learned. Perhaps even spend some time reviewing the material, because in the final section you will learn how to incorporate FRedit into your editorial workflow.
Sample workflow using FRedit
Now that you know how FRedit works and how to set up a FRedit list, let’s look at where in your workflow FRedit functions.
1.	Project files received from the client.
2.	Familiarize yourself with the project parameters and requirements.
3.	Begin populating your style sheet with required style conventions and other information known at the start.
4.	(optional) Run ProperNounAlyse to discover spelling inconsistencies in proper nouns. (If you are unfamiliar with ProperNounAlyse, the Macros from Square One guide explains. Or watch this video.)
5.	Set up your FRedit list with the global punctuation and style conventions from your style sheet, and the results from ProperNounAlyse, if you ran it.
6.	(optional) Other analysis macros that you may want to run to help you populate your FRedit list and style sheet: HyphenAlyse, CenturyAlyse, DocAlyse, and AccentAlyse. This video provides an overview of these and others.
7.	Run FRedit on a copy of the manuscript and adjust your FRedit list as needed based on the results.
8.	When you are confident with your FRedit list, you are ready to run FRedit on your working document. Remember to turn on Track Changes if you want FRedit’s changes tracked.
9.	(optional) Run PerfectIt. Now that you’ve cleaned up the document using FRedit, PerfectIt will run more quickly.
10.	Edit the document as normal.
11.	When you have completed your edit, maybe run some of the analysis macros and/or PerfectIt again to check that you haven’t missed (or added!) any inconsistencies.
Tips for using FRedit
Here are some tips and reminders to help you get the most out of FRedit.
1.	Start by setting up a simple FRedit list (perhaps just removing double spaces and correcting dashes and straight quotes). When you are first learning, it’s better to use FRedit to correct just a few things than to overwhelm yourself by trying to do too much. You could even start populating your FRedit list using the useful entries in the exercises. With each new project, slowly expand what you use FRedit to correct, growing your skills at a sustainable pace. 
2.	Before running FRedit on your document, test your FRedit list on sample text or a copy of the document to make sure FRedit does what you think it’s going to do. Remember: FRedit does exactly what you tell it. If FRedit makes a ‘mistake’, it’s because it was following your directions. Adjust your FRedit list as needed, and test it again until you get the results you want.
3.	You will likely want to create a different FRedit list for each project, as the entries will vary based on each project’s parameters. To make the process of setting up a FRedit list more efficient, you might want to maintain a base FRedit list containing frequently used FRedit entries, which you can quickly copy over to each new FRedit list.
Helpful FRedit resources
If you have questions about FRedit or want inspiration for different ways you can use it, check out these resources. But don’t feel obliged to look at them right now. What you have already learned about FRedit will increase your editing efficiency. This information is provided for when you want to explore further. 
•	A list of Paul’s video tutorials about FRedit.
•	Paul’s video on macro-enabled book editing demonstrates how to use FRedit to edit a book manuscript.
•	The FRedit Library provides an array of find-and-replace entries already set up for FRedit, which you can copy for your use. Many of the entries use a chain of multiple find and replaces to achieve an end, some using wildcards. But you don’t need to understand how they work – just copy and paste them into your own FRedit list. (If you want to learn about wildcards, there are lots of resources on the Word Macro Tools website.)
•	The complete FRedit Instructions file not only covers the material you’ve learned but also describes additional FRedit features and functionality. You can access this file by downloading the FRedit zip file.
Want to learn about FRedit’s cousin – MultiSwitch?
FRedit and MultiSwitch are related. Both are find-and-replace macros. While FRedit works globally, MultiSwitch works locally. MultiSwitch takes over where FRedit leaves off, tackling the context-dependent find and replaces – meaning that you need to assess the surrounding text to determine if an edit is warranted, such as with the prior ‘workout/work out’ example. You can learn how to use MultiSwitch through the MultiSwitch from Square One self-tutoring guide. You can also watch this video about the difference between the two.
Good luck!
Questions? Feedback? Please email Paul Beverley: paul@archivepub.co.uk
Maybe buy us a coffee as a thank-you? ko-fi.com/MrMacros

Want to learn about one new macro each month, plus tips about using macros? Sign up for the Macro of the Month newsletter:
https://macroofthemonth.substack.com
Lead author: Jennifer Yankopolus, jennifer@wordcollaborative.com
[bookmark: _Hlk107052716]Mistakes added by: Paul Beverley, paul@archivepub.co.uk


[bookmark: _Appendix_1:_useful]version date: 30 May 2024

[bookmark: _Appendix_1:_useful_1]Appendix 1: useful character codes
Here are some common character codes you might need for FRedit. In most cases, you can simply type the character you want, but for things like a regular space, which may be invisible to the eye, or a nonbreaking space, even more invisible, character codes help you set up your FRedit list correctly. Using the codes for straight quote marks prevents Word’s autocorrect from changing it to a curly mark.
	code
	explanation

	^32 
	regular space

	^s 
	nonbreaking space

	^34
	straight double quote marks (")

	^39   
	straight single quote marks (')




To obtain additional character codes, consult Appendix 5 of Paul’s free e-book about his macros (all the chapters can be accessed here; a link to download a Word version of the book can also be found on that page).


[bookmark: _Appendix_2:_summary]Appendix 2: summary of FRedit list elements and features 

	Code
	Result

	| FRedit
	You must include this text at the beginning of your FRedit list.

	|track = yes
	FRedit will check that you’ve turned on tracking and prompt you if you haven’t.

	| explanation of a FRedit entry
	Place a vertical bar at the start of the line and FRedit will ignore the text that follows, letting you add a note or explanation. 

	find|replace
	Apply a strikethrough to the entire line and the edit won’t be tracked.

	find|replace
	Apply highlighting to the entire line and FRedit will highlight the edit so you can verify it as you are editing.

	Find|Replace
find|replace
	To change both uppercase and lowercase instances of a term, include two entries. FRedit is case-sensitive. 

	find|find

	Use this format to flag easily confused words, filler words, biased words, etc. Repeat the find word on the right side of the vertical bar and apply highlight and strikethrough the entire line. FRedit will only apply highlighting to that word or phrase (without tracking it). 








OPTIONAL Here are two advanced techniques for those who would prefer a more succinct FRedit list:
	Code
	Result

	

¬find|replace
	Place the bent pipe character (¬) at the beginning of the entry and FRedit will change uppercase, lowercase, and ALL CAPS instances of the term. You can find this character in Word’s Symbol () menu, on the Insert tab of the ribbon. 

	

find|^&
	To highlight a word, such as the easily confused ‘compliment’ and ‘complement’, place ^& on the right side (instead of find|find). The ^& tells FRedit to replace the word with itself. This technique makes it easy to discern the intent of the entry at a glance.




[bookmark: _Answer_Key]Answer Key
[bookmark: miniExercise1]Exercise #2: 
If your answers differ, reflect on what your FRedit entries are asking FRedit to do and how that differs from the below answers. To help you diagnose incorrect answers, you may want to create a test document containing the find elements in question run your FRedit list on it. Notice where the errors are occurring, adjust your FRedit list accordingly and rerun FRedit on the uncorrected text.

1.	health care|healthcare

2.	CO2|carbon dioxide

3.	^32--^32|—
(Instead of ^32, you could insert a space using the space bar, but since it’s nearly invisible to the eye, it’s difficult to scan the entry to determine if it is correct.)

4.	0’s|0s 
(You could write 1920’s|1920s. But that would change only this decade.)

5.	
th|th
st|st
nd|nd
rd|rd
(You could write 1st|1st, but that wouldn’t change 2nd, 3rd, etc.)

6.	^s|^32




[bookmark: miniExercise2]Exercise #4: 

Part A
1.	Replaces lowercase instances of ‘skillset’ with ‘skill set’ and does not track the change.
2.	Changes a superscripted zero to a proper degree symbol.
3.	Abbreviates ‘January’. (To abbreviate all the months, create a FRedit entry for each.)
4.	Highlights the word ‘manufactures’ to help you catch places where the author meant ‘manufacturers’. It also does not track this change so as not to clutter the document. You can also write the entry as (see Appendix 2 for an explanation.):
manufactures|^&
5.	Changes uppercase and lowercase instances of ‘firstly’ to ‘first’. 
If you prefer, you can write it as (see Appendix 2), which will also change FIRSTLY to FIRST:
¬firstly|first
Part B
1.	There is an extra space after ‘problem-solving’, which will result in two spaces appearing after the word: the one that is already there and the one FRedit adds.
2.	The entry is meant to place a full stop inside closing quotation marks and not track the change. But the initial quote mark is facing the wrong direction. (That’s easy to do with Word’s auto styling because it expects you to type an opening quote mark first). 
3.	This may not be a good candidate for FRedit. It would introduce an error in a sentence like ‘The trail heads south toward the lake.’ If your document is heavy with both words, have FRedit highlight all instances instead so you can assess their accuracy while you are editing:
trail head|trail head
trailhead|trailhead
Or if you prefer (see Appendix 2):
trail head|^&
trailhead|^&





